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About this document

This document explains how the Evaluation Kit for the NextGen Solenoid Driver ICs TLE92464ED and
TLE92466ED are taking into operation. The required hardware and software components for the evaluation of
the Next Gen Solenoid Driver IC TLE92464ED/TLE92466ED are documentated. See the TLE92464ED/TLE92466ED
datasheet for a detailed description of the device.

Note: All references of the TLE92464ED Evaluation board within this document are also valid for
TLE92466ED Evaluation board.

Intended audience

This document is intended for anyone who uses the Next Gen Solenoid Driver Evaluation Kit.
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1 Hardware

The Evaluation Kit is available in two versions. Version S includes an Eval PCB with an Arduino form-factor. It
supports a quick and easy plug & play evaluation of the Next Gen Solenoid Driver. Version L includes the Eval
PCB and an additional Connection PCB. The Version L is the more advanced setup option for detailed
laboratory measurements.

1.1 Eval PCB

The Version S includes the Evaluation PCB with the Next Gen Solenoid Driver TLE92464ED and all required
external components on it. The Evaluation PCB is desgined on an Arduino Formfactor which makes it
controlled by all Arduino compatible microcontroller boards, e.g.:

Infineon XMC1100 Boot Kit
Infineon XMC4700 Relax Kit

Aurix ShieldBuddy TC275
Arduino Uno

Figure 1/Figure 2 give an overview of the component blocks on the Evaluation PCB for
TLE92464ED/TLE92466ED. The IC itself is powered with 5V via the microcontroller board (version S) or the
Connection PCB (version L), respectively. The load supply voltage VBAT which is available at the output channel
connectors can be applied via the VBAT connector in version S (close JP1 - Pin Header, refer Jumper Options).
In version L the VBAT level is supplied via the Connection PCB. The IC is clocked by an external rectangular 2
MHz oscillator. Another external clock source (e.g. microcontroller) can be selected via the ohmic Jumper
(R12/R13). The SPI signals, the ENABLE signal and the RESETN signal must be provided by the microcontroller
to enable a successful communication between the microcontroller and the TLE92464ED. The FAULTN and the
DRVx signal are only necessary if the according features are used. The status LEDs indicate wheter the
corresponding function is active (glowing) or not. The reset source DIP switch enables the selection of different
pins for the RESETN signal. This option is only needed for the operation with multiply Evaluation PCBs.
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1.1.1 Connector Interface for Arduino

The Connector placement of the Evaluation PCB is compliant with the Arduino form-factor. The pinouts are
listed below.

Hl
pa NC wID +33V  +5V  VBAT
IOR_EN‘; M U 1
e RESET RESETS
= -3
S Par
GND
GND )+
'1I_|IN' } IS
550-108-03-G-§
GND
Figure 3 Power Connector X1
Table1 Power Connector X1
Pin no. | Arudino™ Signal Name | Evaluation PCB Signal Name | Description
1 - - -
2 IOREF VIO Voltage level for the SPI-MISO-Signal
(3V3orsv)
3 RESET RESET# Reset signal (low active) for the
TLE92464ED. All Reset signal source
DIP-switches should be open.
4 3.3V +3.3V 3V3volt supply
5 5V +5V 5V volt supply
6 GND GND Ground
7 GND GND Ground
8 VIN VBAT Voltage Level (usually 12V) applied on
the VBAT-Connector to supply the
Arduino board
User Manual 4 V1.1
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Figure 4 Communication Interface Connector X3

Table 2 Communication Interface Connector X3

Pin no. | Arudino™ Signal Name | Evaluation PCB Signal Name | Description

1 108 CS1# SPI Chipselect signal for multiply
Evaluation PCB use. Note: R7 must be
assembled.

2 109 MC-CLK TLE92464ED Clock input signal from the
microcontroller. Note: R13 must be
assembled and R12 disassembled.

3 1010 CSo# SPI Chipselect signal

4 1011 MOSI SPI Master Out Slave In

5 1012 MISO SPI Master In Slave Out

6 1013 SCLK SPI Clock (max. 8 MHz)

7 GND GND Ground

8 AREF AREF Analog reference Pin - not connected

9 SDA SDA 12C SDA Pin - close DIP switch 2 to use it
as reset signal source (digital 10)

10 SCL SCL 12C SCL Pin - close DIP switch 1 to use it
as reset signal source (digital 10)
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Figure 5 Digital 10 Connector X5
Table 3 Digital 10 Connector X5
Pin no. | Arudino™ Signal Name | Evaluation PCB Signal Name | Description
1 100 RX UART Receive - close DIP switch 4 to
use it as reset signal source (digital 10)
2 01 TX UART Transmit - close DIP switch 3 to
use it as reset signal source (digital 10)
102 EN TLE92464ED Enable Input Pin
103 FAULT# TLE92464ED Fault Output Pin
104 DRVO TLE92464ED DRVO Pin for direct drive
mode of Channel 0
6 |05 DRV1 TLE92464ED DRV1 Pin for direct drive
mode of Channel 1
7 106 DRV2 TLE92464ED DRV2 Pin for direct drive
mode of Channel 2
8 107 DRV3 TLE92464ED DRV3 Pin for direct drive
mode of Channel 3

X4
ADD }"i_ NC
g Al H— e
é m; H_:d» NC
< apa 3 NC
ADs 318 NC
£50Q-106-03-G-5
Figure 6 Analog Connector X4
Table 4 Analog Connecotr X4
Pin no. | Arudino™ Signal Name | Evaluation PCB Signal Name | Description
1 ADO X4.1 Not connected
2 AD1 X4.2 Not connected
3 AD2 X4.3 Not connected
4 AD3 X4.4 Not connected
User Manual 6 V1.1
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Pin no. | Arudino™ Signal Name | Evaluation PCB Signal Name | Description

5 AD4 X4.5 Not connected
6 AD5 X4.6 Not connected
1.1.2 Jumper Options

On the Evaluation PCB are various configuration options available to enable all features in both versions (S and
L) and to test the chip in different conditions. The jumper options are descriped in the table below.

Table 5

Jumper Options

Jumper

Jumper Designation

Description

IC Clock signal source

R12 (default)

External 2MHz Oscillator source

R13

Microcontroller Clock source via Connector
Pin MC-CLK (e.g. PWM signal)

Chip select signal source

R11 (default)

SPI chip select via Connector Pin CSO#

R7

SPI chip select via Connector Pin CS1#

Reset signal source

DIP Switches open (default)

RESET# Pin as Reset signal source

DIP Switch 1 closed

SCL Pin as Reset signal source

DIP Switch 2 closed

SDA Pin as Reset signal source

DIP Switch 3 closed

TX Pin as Reset signal source

DIP Switch 4 closed

RX Pin as Reset signal source

VBAT supply Pin header JP1 closed (default) | Supply Output Connector with VBAT voltage
level via VBAT-EXT Connector
Pin header JP1 open Evaluation PCB Output Connectors are
supplied via the Connection PCB
Note: Open for use with Connection PCB
1.1.3 LEDs

The Eval PCB has five LEDs which indicate the status and operating conditions of the IC. The meaning of the

status LEDs is descriped below.

Table 6 LED description

LED designation TLE92464ED Pin designation Description

FAULT FAULTN (low active) Glows if the IC detected a fault condition

ENABLE EN (high active) Glows if the IC is enabled

RESET RESN (low active) Glows if the ICis in reset state

VIO 3.3V VIO Glows if the VIO Pin is connected to 3.3V
(voltage level for SPI MISO Pin)

VIO 5V VIO Glows if the VIO Pin is connected to 5V
(voltage level for SPI MISO Pin)

1.2 Connection PCB

The version L includes the Evaluation PCB, the Connection PCB and an Infineon Aurix TriBoard TC277. The
Connection PCB supports the evaluation of up to three Evaluation PCBs in parallel. Furthermore it provides
advanced measurement options and one high side switch for each Evaluation PCB. The control unit for version

User Manual
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Lisintended to be an Infineon Aurix TriBoard TC277 which can be plugged on the Connection PCB. Figure 1
gives an overview of the Connection PCB.

Note: For use of the Connection PCB please open the Pin header Jumper on the Evaluation PCB (see
1.1.2)

TriBoard TC277  Supply voltage

slot 5 5\ — 40V Eval PCB slot

Output
connectors

High side FETs and
measurement options

Figure 7 Connection PCB without TriBoard and Eval PCB

1.2.1 Connector Interface for TriBoard TC277

All three Evaluation PCB slots are connected to the TriBoard TC277 microcontroller board to enable the feature
set of the Evaluation PCB. One SPI interface with three different Chip Select signals is used for the
communication between the microcontroller and the Evaluation PCBs. Each digital 10 signal (Enable, Reset,
Fault, high side FET on/off, direct drive pins) is connected to an individual digital |0 pin.

Note: For detailed pin assignment documentation see the Connection PCB schematic.

An individual Evaluation PCB reset can be triggered by software. The corresponding digital 10 pin must be set to
low. A reset signal for all three Evaluation PCB can be trigger via the PORST# signal of the TriBoard either by
software or the corresponding button. Unused common signals (e.g. UART, 12C) are kept available for any
extension.

User Manual 8 V1.1
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1.2.2 Jumper Options

The Connection PCB can be configured via some Jumpers which are described below.

Table7 Jumper Options
Jumper Jumper Designation | Description
High side FET JP6Xx Close for use without high side FET
High side FET controlling | JP5x 3-4 “EN#” High side FET is controlled by the microcontroller via two
(default) digital 10-Pins (active on low level)
JP5x 1-2 “VBAT” Deactivates the high side FET (continuous off)
JP5x 5-6 “GND” Activates the high side FET (continuous on)
Direct Drive Pins JP1x, JP2x, JP3X, Direct drive Pins are controlled by the microcontroller
JP4x 3-4
“DRVX” (default)
JP1x, JP2x, JP3X, Set direct drive pins to VIO level (5V default).
JP4x 1-2
“VvIO”
JP1x, JP2x, JP3X, Set direct drive pins to GND level.
JP4x 5-6
“GND”
1.3 Version S setup

In Figure 8 a basic setup for the Version S of the Evaluation Kit is shown. On the external supply connector the
voltage for V,,.in the range of 5.5V up to 40V can be provided. The output channels are supplied with V,,. by
closing the Jumper JP1 (refer Table 5). If the XMC1100 microcontroller is flashed with the Commando
Interpreter software the TLE92464ED can be controlled via the USB connection by the PC. The USB connector
can also be used to falsh and debug own embedded software. It is recommended to use the DAVE IDE for
programming XMC microcontrollers (https://www.infineon.com/cms/de/product/microcontroller/32-bit-
industrial-microcontroller-based-on-arm-registered-cortex-registered-m/dave-version-4-free-development-
platform-for-code-generation/channel.html?channel=db3a30433580b37101359f8e€6963814).

User Manual 9 V1.1
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| USB connection to PC

solenoid @
Channel 0

@ T o= N Jumper closed for
: vaa : supply with Vbat
Vbat supply
’.I ]l : ! 4(‘3&.(7 ‘.}—
Figure 8 Setup example for Version S (XMC1100 Boot Kit with TLE92464ED Evaluation board)

Close IOREF jumper

Cortex Debug  Ethernet ’“:‘l’"‘:z"? RTC 00hm
(10Pin)  RJ45 & PHY probecenrys Crystal Bridges
Reset 0 Ohm XMC4700
microSD Button Micr Pin Header X1

Debug 2 User CAN Arduino Pin Header X2
Micro g8 PR iy oo m:: ARDUINO
OM LE LED ANALOG IN) Pin Header
XMC4200 User Voltage 12 MHz qSPI Flash Micro USB
Debug IC & LEDs Crystal PCB_Block et
Figure 9 XMC4700 considerations - Evalboard setup is identical to XMC110, but the IORER jumper

on the XMC board needs to be closed
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1.4 Version L setup

In Figure 10 a Version L setup with one Eval PCB and a TC277 microcotroller TriBoard is shown. The main
voltage input is connected to the upper middle connectors and supplies the whole board setup inclusive loads.
Take care on maximum current ratings. In case of using Eval PCBs in parallel supply the board via all four
supply connectors (two red, two black). Each Eval PCB slot has its own SPI chip select signal to support an
individual communication. The slots are named alphabetic. In Figure 10 a solenoid is connected to Channel 0 at
slot A of the connection PCB. If the TC277 microcontroller is flashed with the Commando Interpreter software
the TLE92464ED can be controlled via the USB connection by the PC. The USB connector can also be used to
falsh and debug own embedded software. It is recommended to use the TriCore Entry Toolchain
(https://www.infineon.com/cms/de/product/microcontroller/32-bit-tricore-tm-microcontroller/tricore-tm-
development-tools-software-and-kits/free-tricore-entry-tool-
chain/channel.html?channel=db3a304344134c7a014420d628fa76ec).

Power supply (5.5V - 40V)

USB Connection

solenoid @ CHO on
| Evaluation PCB slot A

8873  pes

Aurix .
TriBoard BE. e e SE

./‘ -
Infineon

E IR e : RytatdRge anadg ™ Safing FET
E UG pe) @@ @@ ® ; | 0 J for slot C
JOd 11 o00 000 000 ooo O Im'J e -
‘ — slot C

000000000000
0.0.000 ooocoe

o0
oo
oo e
00

00000000 ; o
o000 3
28886000000000000 Infineon g

©0000000000000000

o GND
OOODOOOOOOOOOOOO
°°°°°°°°°°°°°§3§§ Solenoid Driver Icpggabllgauon Kit
OOODOOOOOOOOO Connection §
00000000000000000 oPeE O s

Figure 10 Setup example for Version L with a TC277 TriBoard

1.5 Schematics

This chapter contains the schematics of the Evaluation PCBs and the Connection PCB.
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Schematic of the Connection PCB - Overview
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Schematic of Connection PCB - TriBoard Connector 2

Figure 15
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Schematic of Connection PCB - Evaluation PCB Connectors

Figure 16
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2 Software

Before using the GUI, the seleceted microcontroller must be flashed with the communication firmware. The
sections Flashing/Updating Aurix TC277 Software and Flashing/Updating XMC Software explaining the steps to
be taken for a successful flashing of the microcontroller GUI interface software.

2.1 Flashing/Updating Aurix TC277 Software

Following steps should be taken to flash the Aurix TC277 Triboard and enable a communication with the GUI:

e Plugthe TriBoard and the Evaluation PCB on the Connection PCB

e Install the Infineon DAS-Tool inclustive drivers on your computer
(https://www.infineon.com/cms/en/product/promopages/das)

e Install the Infineon Memtool SW: https://www.infineon.com/cms/en/product/microcontroller/32-bit-tricore-
microcontroller/#!tools (NOTE: DAS-tool should already be installed)

e Supply and connect the Evaluation board

o Select the Target TriBoard (Target -> Change -> new)

o Select the appropriate Triboard (Tricore Aurix -> Application Kits (DAS) -> Application Kit with TC277T D-Step
(DAS))

e Click the Connect button in Memtool and load the provided HEX file via the button “Open file”
e Click “Select All”, Click “Add Sel.”, Click “Program all”
e Asmall window should pop up and program the Aurix. The “result” should show “success”

X Infinean - Memtool 4.7 an Application Kit with TC277T D-Step (DAS) — d
File Target Device Log Help
File : FLASHAOTP - Memom Device
C:hJzersEckert)a\Desktophaurnis Fimware \WGFPwW_TCZ77 PFLASHO: 2 MByte OnChip Program FLASH - v Enable
[+

0x30000000 - 080000027 P i Index | Start End Size Erase ...

DAE0000040 - DB000000F - ; 0 0:A0000000  OeA0003FFF 16K

0480000700 - 0xB001AFCE S clect Al

D4E001AFDD . D+B001AFDF elect 1 0240004000  OxA000FFFF 16K

0020000 - (+B002001F 2 040008000  OxA000BFFF 1EK

DWam1FA020 - ol FADZD 3 DA000COOD OwAODOFFFF 16K | |

B0 F4040 - NwE01F404D 4 0400710000 0=40013FFF 16K

04B01F4050 - 04801F40ED Savehs B 0:40014000  Ox001FFFF 16K S Pratact...

048014080 - 04801F4080 B 0w40018000  Ox8001BFFF 1EK

04801F4040 - 0+B01F404D0 Fead . 7 D:A001CO00  Ox00TFFFF 16K UCEs

04801F40C0 - 0%801F40CD 8 wA0020000  Ow80027FFF 32K

04B01F4EED - 04801F4EED 9 (wADD2B000  OwAO02FFFF 32K

3”33} Eigﬁﬂu 3”381 Eigﬁ% Q 10 0240030000 ORAO00FFFFF 32K v M

bt - L

04B01F4730 - 0x801F4730 < ?

0+801FE000 - (%8071 FROFF

0+B01FE200 - 0%801F7R07 w7 Setup ..

.,r"""': Tool
I n fl n eon M |Fiead_l,l for Mermtool Commatd Help | Exit

Figure 21 Successful flashing setup of Memtool
2.2 Flashing/Updating XMC Software
The Evaluation board can be fully controlled via the GUI by following Infineon XMC board

e XMC1100 Boot Kit (SP001069652)

e XMC4700 Relax Kit (SP001427974) - recommended
User Manual 22 V1.1
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A full GUI support for the Version S setup presupposes the according microcontroller firmware for correct
interaction. The according Firmware for the XMC1100 and XMC4700 is provided as .hex file in the GUI folder
under “XMCFirmwareFiles”. The flashing of the XMC microcontroller is explained by means of XMC1100 (please
refer XMC4700 RelaxKit “Getting started”-guide).

Flashing XMC4700 Microcontroller is done via the J-Link Flash lite which can be obtained from the segger
website (https://www.segger.com/products/debug-probes/j-link/technology/flash-download/).

Upon opening JLink Flash lite, this screen pops up:

Kl IR ERES
Device Interface
| XMC4700-2048 | SWD v |4000kHz v oK
Figure 22 Segger J-Flash Lite start up - select microcontroller

When executing J-flash lite, select the XMC 4700 microcontroller as shown inFigure 22. By clicking ok, the
flasher tool pops up where the downloaded firmware needs to be selected in the section “Data File”. If the
Relax Kit is connected via USB, the firmware can be flashed onto the microcontroller and the J-falsher should
acknowledge the successful flash operation as shown in Figure 23.

B = | B | = |
Target
Device Interface Speed
| XMc4700-2048 | |swp | | 4000 kHz
Data File (bin /hex / mot fsrec f...) Prog. addr. (bin file only)
irm'.r-.'arEFilesfxmﬂ?DD.hex | |I:IxIIII:II:II:IIIII:II:II:I | Szl

Program Device

Log

Selected file: C:/Usersfkaffigeo/GIT_EVAL_GUI/XMCFirmwareFiles,xmc4700.hex
Conecting to JLink...

Connecting to target...

Downloading. ..

Done

Ready

Figure 23 Successful flashing of the XMC4700 microcontroller

2.3 XMC for Arduino IDE

Own software projects can easily be written and updated to the XMC microcontroller boards.
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e Install Arudino IDE
¢ Install Infineon “s XMC Microcontroller Boards for Ardunio: https://github.com/Infineon/XMC-for-Arduino

e Create your own SW Project
e Compile the project (Sketch -> Verify/Compile)

e Connect the XMC1100 Boot kit/XMC4700 Relax Kit via USB and upload the compiled project (Sketch ->
Upload)

2.4 Graphical User Interface (GUI)

The GUI can be use either with an XMC or TriBoard (incl. Connection PCB) setup. Both setups require a
microcontroller software for the communication with the GUI. The steps to flash the used microcontroller with
the firmware is explained in the previous sections.

Following steps should be taken to start before starting the GUI (see also “getting started”):

e XMC: Pluga 12V supply into VBAT_EXT and GND and connect the XMC board via the USB connector to the
computer (see Figure 8)

e TriBoard:
o Please install the DAS tool (see 2.1)
o Pluga12Vsupply into the VBAT_EXT and GND Connectors on the Connection PCB and connect
the TriBoard via the USB connector with your computer (see Figure 10)
e Start the GUI and connect to the right COM Port

e When setting the EN Checkbox the EN-LED on the Eval PCB should glow and the communication to the
Solenoid Driver IC is fully operational.

2.4.1 Main Window

After starting the GUI a dialog window will pop up (Figure 24). From the first drop-down menu, select the
connection PCB or the microcontroller board (XMC1100 or XMC4700) which is being used to interface with the
evaluation board. Based on the first selection of either a common connection PCB or XMC microcontroller
board, it is possible to test either three or one evaluation board respectively. If the common connection PCB
was first chosen, the three IC evaluation boards being used should be selected for each slot from the three
subsequent drop-down menus. Alternatively, if a XMC is the tool of choice, then the user can only an evaluation
kit for Slot Ain the dialog window shown in Figure 24.

ny %[ =

Connection and Slot Selection

Select Connection-PCB/ Microcontroller Board

Please Select Connection-PCB 2

Slot A {Top Right)

SlotB { Middle Right)

Slot C { Bottom Right)

o

Figure 24 Slot selection for the Connection PCB
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After selecting the connection-PCB or microcontroller board from the first drop-down menu, a prompt pops up
for selecting the COM port for the USB- Serial interface. Locate the correct port in the ‘Ports’ section of the
Device Manager on your PC’s Control Panel.

m 7 |= ]

COM10: {Infineon DAS JDS COM (COM10)) 7

Figure 25 COM port selection

Once the correct COM port is identified, the GUI starts up in its default state, see Figure 26.

& NV
Kt W
i o -
Yool - . ot 1
T 4 = vore Nim 3 e e S S
1 View Button g o oo |8
] ey '
‘ B -
\ — = L
. Lole N
| @~ - @
@= - @ -
| @ ™~ [~
| = = AAEATSEF SN
l @ @~ @ @
Connect Button - bcarnks u;’ - e
Macro-loading tab S
O i o ® = ®
[ @~ @ s
| - — - pov
|
Initialized evaluation board tabs 1 o
| w - > L
| e - &) o
7/ W @ @
g ‘/" . o -
— - | = e Cinaeis T G v | = =
Figure 26 Main window overview

The Connect button in the top left corner opens the slot-selection menu. Next to it is the View menu which
offers different layout options for the main window, such as hiding certain widgets or tabs, as well as saving the

layout preferences. The bottom left corner has three buttons for switching across the three tabs corresponding
to the three evaluation boards.

One useful feature of this GUI is its ability to load and run a user-written macro sequence, as an alternative to

utilizing the evaluation board tabs. The user can write a command sequence by activating the Macro Recorder
indicated by as Macro loading tab in Figure 26.

2.4.2 Evaluation Board Tabs

If selected, each EvalBoard gets their own Tab in the MainWindow, which contains all available controls for that
particular board. The Tab for the TLE9246x family of devices is structured in 5 main widgets as can be seen in

Figure 27.
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Global control

[ ]
e Channel widgets
o Diagnostics
e SPlregister widget
B L Evaluation board TLES2466 has been Global control: General functions like Reset, Enable.
e initialized on slot A (slot 1). — -
i — - -
e hepan mg # n| | cebe— # o fm )
= . ---ul : . s e foar e P ':n B I"'
= e
] - 1 -
e =
- = - f
B @ @ [ @
& oo @ = | @ o
== == e o | —
- | .
[T e [~ | =g,
H.,.- - [~ [~ R | gl o
= R e |
Diagnostic: Displays the state L, o o e .l e )
of t!‘l& an-chip diagnostic / =T = 1-_-:_-~ “ | Channel Widget: controls
registers. S for each channel,
=y [ Setpoint, Dither,
o e - - -
o - DirectDrive (if available).
e ; -
5Pl register widget: Gives read and write
access to the chip’s registers.
Figure 27 Example TLE92466 GUI Tab
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To configure the evaluation boards with the GUI, the following sequence is recommended
e Reset the Chip by unchecking and the re-checking RESN via GlobalControl

e Setappropriate channel settings in the CHx registers.

e Activate needed channels in Central -> CH_CTRL register

e Activate MissionMode in the Central -> CH_CTRL register

e Enable the Chip by setting EN via Global Control

Additionally, the watchdog value can be modified using the slider on the global control widget. The watchdog
is, however, triggered properly at startup and does not need to be configured.

The Diagnostics widget displays the state of the chip’s diagnostic registers, by default, these values don’t
update automatically, for this you need to check the AutoUpdate checkbox in GlobalControl
2.5 Information on the GUI communication interface

The GUI software sends commands via UART to the TriBoard based on the User input. The TriBoard
microcontroller firmware decodes the commands and excutes them accordingly. The following list shows
available commands that can be used to directly execute commands with the help of a terminal program.

e Allvalues have to be typed in as hexadecimal numbers. If the first digit is alphabetic, a zero has to be
typed in front of the value.

e The Connection-PCB must be initialized on startup. The type of Connection-PCB is displayed on startup
or when entering the help() command.

e For most commands a slot number (slot) has to be entered. Slot 0 selects the Connection PCB. The Eval-
PCBs are enumerated according to the slot naming shown in figure 11 (Slot A: (1) to Slot C: (3). The
XMC1100 has a single slot (1) only.

e Not all Eval-PCBs can be mounted on every slot. The user can initialize Eval-PCBs by the initialization
commands and the slot number. The type of initialized Eval-PCBs is displayed when entering the help()
command.

e CRCs, Parity Bits or similar have to be calculatet by the user.

e The UART interface should be configured as shown in following figure.

3
Port: COM3 ~ oK
Baud rate:
Data: 8 hit ~ Cancel
Parity: none ~
Stop: 1 bit v Help
Flow control: none v
Transmit delay
EI msecfchar EI msecfline
Figure 28 UART setup
2.5.1 List of Commands
e InitEvaINGSD(slot) - NGSD-Connection-PCB (slot 1 or 2), Microcontroller board slot 1.
User Manual 27 V1.1
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e help() - help

Displays board info, names and command list.
Returns 0 always.

o delay(ticks) - delay

Waits for ticks time in milliseconds.
Returns ticks.
Expected values:

* ticks: [0x1] to [FFFFFFFF]

ior(slot, ioDev) - io read
Returns state of input or output ioDev, if successful.
Expected values:
= slot: [0] to [3], depending on the initialized boards
= joDev: Names displayed in help command or XMC1100 Bootkit IO numbers depending on the
initialized boards

iow(slot, ioDev, outState) - io write

Writes outState to outputioDev.
Returns outState, if successful.
Expected values:
= slot: [0] to [3], depending on the initialized boards
= joDev: Names displayed in help command or XMC1100 Bootkit IO numbers depending on the
initialized boards
= outState: [0] or [1]

iop(slot, ioDev, outState, ticks) - io pulse

Sets ioDev to outState for the time of ticks ms, then sets ioDev to inverse outstate.
Returns ioDev, if successful.
Expected values:
= Slot: [0] to [3], depending on the initialized boards
= |oDev: Names displayed in help command or XMC1100 Bootkit IO numbers depending on the
initialized boards
= QutState: [0] or[1]
= Ticks: [1] to [FFFFFFFF]

e iowt(slot, ioDev, inState) - io wait

Waits until ioDev has the value of instate.
Returns inState, if successful.
Expected values:
= slot: [0] to [3], depending on the initialized boards
= joDev: Names displayed in help command or XMC1100 Bootkit IO numbers depending on the
initialized boards
= inState: [0] or [1]

e spi(slot, spiDev, out) - spi write
Sends an spi command with content out to device spiDev (normaly 0).
Returns the return value of the previous command, if successful (previous command can be the
watchdog command, if activated).
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Expected values:
= slot: [0] to [3], depending on the initialized boards, msc is only available for slot [3] on Engine-
Management-Connection-PCB yet
= spiDev: [0]
= out: [0] to [FFFF] or [0] to [FFFFFFFF], depending on the datawith of the particular Eval-PCB

e spis(slot, spiDev, outl, out2, ticks) - spi sequence

Sends two spi commands with a delay of ticks ms to device spiDev (normaly 0).
Returns the return value of the command before the second command, if successful (watchdog
command can be sent between both commands, if activated).
Expected values:
= slot: [0] to [3], depending on the initialized boards, msc is only available for slot [3] on Engine-
Management-Connection-PCB yet
= spiDev: [0]
= outx: [0] to [FFFF] or [0] to [FFFFFFFF], depending on the datawith of the particular Eval-PCB
= ticks: [1] to [FFFFFFFF]

e spir(slot, spiDev, out, nop) - spi read
Sends two spi commands in quick succession to device spiDev (normaly 0).
In contrast to other spi functions not interrupted by watchdog.
Returns the return value of first command (which is received while sending the second command).
Second command can either be a "no operation" value or another command whose answer is not
needed.
Expected values:
= slot: [0] to [3], depending on the initialized boards, msc is only available for slot [3] on Engine-
Management-Connection-PCB yet
= spiDev: [0]
= out: [0] to [FFFF] or [0] to [FFFFFFFF], depending on the datawith of the particular Eval-PCB
= nop: [0] to [FFFF] or [0] to [FFFFFFFF], depending on the datawith of the particular Eval-PCB
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IMPORTANT NOTICE

The information given in this document shall in no
event be regarded as a guarantee of conditions or
characteristics (“Beschaffenheitsgarantie”) .

With respect to any examples, hints or any typical
values stated herein and/or any information
regarding the application of the product, Infineon
Technologies hereby disclaims any and all
warranties and liabilities of any kind, including
without limitation warranties of non-infringement
of intellectual property rights of any third party.

In addition, any information given in this document
is subject to customer’s compliance with its
obligations stated in this document and any
applicable legal requirements, norms and
standards concerning customer’s products and any
use of the product of Infineon Technologies in
customer’s applications.

The data contained in this document is exclusively
intended for technically trained staff. It is the
responsibility of customer’s technical departments
to evaluate the suitability of the product for the
intended application and the completeness of the
product information given in this document with
respect to such application.

For further information on the product, technology,
delivery terms and conditions and prices please
contact your nearest Infineon Technologies office
(www.infineon.com).

WARNINGS

Due to technical requirements products may
contain dangerous substances. For information on
the types in question please contact your nearest
Infineon Technologies office.

Except as otherwise explicitly approved by Infineon
Technologies in a written document signed by
authorized representatives of Infineon
Technologies, Infineon Technologies’ products may
not be used in any applications where a failure of
the product or any consequences of the use thereof
can reasonably be expected to result in personal

injury.
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